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Part 180 – Conservation Planning and Application 

Subpart 396 – Standard Operating Procedure for the Highly Erodible Land 
Conservation and Wetland determination Process 

396.0 Purpose 

This instruction provides the Standard Operating Procedure (SOP) for the Highly Erodible Land 
Conservation (HELC) and Wetland Determination process and related conservation compliance 
technical assistance workflow. 

1. Consistent statewide process for referring and routing HELC and Wetland Conservation 
(WC) compliance requests, 

2. Reduce redundancy in completing compliance determinations, 
3. Digital backup for such requests, 
4. Uniform nomenclature for compliance-related referral documents, 
5. Single-shared access point for retrieving, tracking, and forwarding requests for staff with 

HELC and WC responsibilities, and 
6. Consistent process for ensuring accountability with current policy timeframe obligations. 

396.1 References 

Title 180, National Food Security Act Manual, 5th Edition 
Title 440, Conservation Programs Manual, Part 510 – Appeals and Mediation 
IA180-516-M, 5th Ed., Amend. 3, Apr 2018 
Iowa Instruction 180-385 Second Edition – Designated Conservationist 
Title 7 Code of Federal Regulations (CFR) Part 12 and Title 7 CFR, Chapter VI, Part 614 –  
  Natural Resources Conservation Service (NRCS) Appeal Procedures 
Iowa Compliance Memo 16–04 

396.2 Abbreviations 

ASTC – Assistant State Conservationist 
CA – Conservation Assistant  
CD – Conservation Desktop 
CED – County Executive Director 
CFR – Code of Federal Regulations  
CLU – Common Land Unit 
CPM – Conservation Programs Manual 
CSS – Compliance Support Staff 
CWD – Certified Wetland Determination 
FA – Functional Assessment 
FIPS - Federal Information Processing Standard  
FO – Field Office 
FSA – Farm Service Agency 
HELC – Highly Erodible Land Conservation  
JAA – Job Approval Authority 
NFSAM – National Food Security Act Manual  
MTP – Mail to Person 
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NRCS – Natural Resources Conservation Service  
SO – State Office 
SOP – Standard Operating Procedure  
STC – State Conservationist 
WC – Wetland Conservation 

396.3 Background 

Iowa NRCS local FO receives technical assistance and referral requests for HELC and WC 
determinations from participants and the FSA via Forms AD-1026, FSA-569, and CPA-038. These 
forms, accompanying maps, and written requests provide information for which NRCS is authorized 
to complete HELC and Certified WC determinations, reviews, service appeals and provide technical 
assistance. This document provides instructions and nomenclature for FO staff to forward 
documents, appeals, and referrals of requests for technical assistance to staff members with 
compliance responsibilities. 

396.4 Contact 

If there are any questions, please contact the ASTC-Compliance at (515) 323-2243. 

396.5 Referral Policy 

Iowa NRCS staff, Partners, and Contractors will follow the process outlined below. 
 

For Preliminary and Final Technical Determinations of HELC and WC 

Note: Prior to referral, FSA should verify whether a previous determination exists for the 
geographic scope of the area of interest. FSA refers the Form AD-1026 or Form FSA-569 when 
initiated by FSA or public whistleblower, with a quality map that includes the Section, Township, 
and Range, and provides the Producer Farm Data reports that contain all the addresses of all 
affiliated owners, operators, or other tenants. 

1. Referral from FSA 
a. Receiving FO staff (i.e., the CA) checks Form AD-1026 or Form FSA-569 to verify the 

following: 
i. Farm, tract, field number(s), and pertinent highlighted project area information is 

included. 
ii. Respective items in Part B of Form AD-1026 (questions 6, 7A, or 7B), are checked 

“YES” by the person, or if Form FSA-569, Part B is appropriately checked for 
applicable circumstance. 

iii. Activity is clearly documented in Part C of Form AD-1026, or a clear red X of 
location on accompanying map with Form FSA-569. 

iv. Signature and date of both the person and FSA representative completed in Part D of 
Form AD-1026 or Part A, numbers 11 and 12 of Form FSA-569. 

v. Legible CLU map, in color, including clearly identified area of interest and known 
historical drainage documentation (if relevant to request). 

vi. Producer Farm Data Report with all affiliates of the tract, including all mailing 
addresses. 

b. If any of the above items are missing, the NRCS FO receiving staff returns the referral to 
FSA to correct the deficiencies prior to date-stamping the referral. 
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Per item 1(a)(ii), Items are as follows: 
2. FO staff date-stamps the referrals with the date NRCS received. NFSAM 510.12(B)(2)(i) 
3. FO staff reviews the NRCS physical file records for prior determination(s), applicable drainage 

information, and/or other relevant information. 
a. If a certified determination is completed for the entire project area requested per NFSAM 

514.1, FO staff sends the previous CWD to the participant. Refer to Exhibit 1 – Existing 
Wetland Determination Template Letter. 

4. FO staff scans the referral documents and physical file records found in step 3 as double-sided, 
in color, to a PDF and emails to SM.NRCS.IA.Compliance using the following file naming 
convention: 

a. Based on the request type for the Form AD-1026 or Form FSA-569 (farm number and 
tract number in the X’s) the FIPS code is the county the tract is administered in, and not 
physically located in. 
i. If physically located in another county or state, make a note stating the physical 

location in the subject line of the email. 
ii. HELC_IAFIPS_FXXXX_TXXXX 

iii. WC_IAFIPS_FXXXX_TXXXX 
iv. BOTH_IAFIPS_FXXXX_TXXXX (Example: BOTH_IA113_F2589_T1123.pdf) 

b. Use physical county name as subject line of email. 
5. CSS retrieves referral from SM.NRCS.IA.Compliance shared email account. 
6. CSS enters the referral into the CD HELC/WC Tracking Tool and uploads new documents to 

CD Document Management based on current user guides.  
a. Note: If the referral is for both HELC and WC determinations, the PDF will be uploaded 

into CD Document Management for each of the separate Document Categories. 
7. Designated Conservationist assigned to the determination retrieves referral from CD Document 

Management. 
a. To find the documents associated with the referral follow current instructions for 

Document Management within CD Help. 
8. Designated Conservationist completes the WC and/or HELC referral. 

a. For WC - If the determination is adverse, the Designated Conservationist notifies the 
producer and District Conservationist of the decision prior to mailing per IA440-510-M, 
1st Ed., Amend. 1, Aug 2019. This policy only applies to WC and does not apply to 
HELC. 

b. For HELC – Refer to GIS Instruction Exhibit 2 - Iowa NRCS HEL Tool for ArcMap 
User Guide for additional guidance. 

9. Designated Conservationist uploads the agency record, including all information used in 
rendering the decision, into both the F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 
county folder directory, and to Document Management in CD. See Exhibit 3 – CD Document 
Management Uploading Guidance. 

a. FIPS county is the county where the tract is administered by FSA. (Example: 
IA017_F3521_T9696) 

b. If there are existing documents in the F:\DATA\IA<firstthreelettersofoffice>\NRCS-
CPA-026 with signatures use Exhibit 4 - Instructions for Appending a PDF. 

10. Designated Conservationist emails assigned CSS a MTP that includes the decision notice letter, 
map, and Form NRCS CPA-026-WC or Form NRCS CPA-026-HELC as a PDF. 
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11. CSS enters preliminary determination completion date into the CD HELC/WC 
Tracking Tool using current guidance. 

12. CSS emails MTP to District Conservationist and FSA CED.   
13. CSS prints the MTP from the email received from the Designated Conservationist in 

Step 10. 
14. CSS mails MTP to respective person(s) as listed on the Farm Data Report.  

a. Non-Adverse decision letters and carbon copy mailings are sent regular mail to 
all associated with the tract.  

b. Adverse decision notices are mailed certified–return receipt requested to all 
associated with the tract per regulation located at Title 7 CFR, Chapter VI,  
Part 614, Section 614.6(b). 
i. Tract number and county are written on the green certified-receipt cards. 

ii. Use the NRCS county where the referral originated from as the return 
address on green certified-receipt cards. See attached Exhibit 5 - Certified 
Mail Return Receipt Guidance. 

15. CSS enters the mailing date into the CD HELC/WC Tracking Tool. 

396.6 Appeals Policy 

1. Request for informal appeals received by FO staff or Designated Conservationist. Note: 
Request for appeals can include reconsideration, mediation, and/or FSA County 
Committee and must be made in writing per Title 7 CFR, Chapter VI, Part 614, 
Section 614.2. 

a. FO staff or Designated Conservationist forwards the request for appeal and a 
scanned copy of the signed certified green card to SM.NRCS.IA.Compliance 
with a carbon copy to the respective Designated Conservationist. 

b. Use physical county and “Informal Appeal Request” in subject line of the email. 
2. CSS retrieves referral from SM.NRCS.IA.Compliance shared email account. 
3. CSS enters the appeal date for the appropriate appeal type into the CD HELC/WC 

Tracking Tool. 
4. Designated Conservationist sends acknowledgement letter of the request for appeal to 

the person requesting per Title 440 CPM, Part 510, Subpart B, Section 510.20(B)(3-4) 
and provides a copy of the agency record to appellant. See Exhibit 6 – Appeal 
Acknowledgement Template Letter. 

5. Designated Conservationist conducts the reconsideration per Title 440 CPM, Part 510, 
Subpart B, Section 510.21(B)  

a. If the decision is no longer adverse, the record is amended accordingly, and the 
final technical decision is provided to the respective person(s) by following step 
9 – 14a and 15 above in 396.5. 

b. If the decision remains adverse, the Designated Conservationist organizes a 
digital copy of the record using Exhibit 7 - 6 Part folder Cover Sheet 
Guidance for WC and Exhibit 8 - Form NRCS-CPA-17 for HELC and places 
it in SharePoint under folder Compliance Internal\Compliance Editable 
Files\Final Determination Folder. 
i. Designated Conservationist sends email notification to the 

SM.NRCS.IA.Compliance with “Final after Reconsideration of same file 
name as in 396.5 (9)(a) above” in the subject line for independent technical 
review as per Title 440 CPM, Part 510, Subpart B, Section 510.21(B)(6). 
Note: Labels associated with adverse decisions include but are not limited to 
CW, CW+yr, CWTE, FW, FWP, W, and WX and HELC. 

6. SO Compliance staff reviews and forwards Form NRCS CPA-026-WC or Form NRCS 
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CPA-026-HELC, Map, and Letter to SO Administrative staff for formatting. 
7. Final Decision Notice and attachments are mailed from STC office. 
8. SO staff enters the mailing date into the CD HELC/WC Tracking Tool. 
9. Additions or amendments to the agency record are saved in the respective 

F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 county folder directory and 
into CD Document Management. 

a. If there are existing documents in the 
F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 with signatures use the 
Instructions for Appending a PDF (Exhibit 4). 

396.7 Request for Review of Previous CWD Policy 

1. Written request for review of a CWD by the producer is received by FO staff or 
Designated Conservationist. See Exhibit 9 – Request for Review. 

a. Request should identify the natural event that altered the topography or 
hydrology of the subject land, or identify the error that was made, or what about 
the wetland was not considered (i.e., drainage records). See NFSAM 514.1(F)(2). 

2. FO staff or Designated Conservationist scans as double-sided, in color, the written 
request including all documents pertaining to the request including but not limited to 
new drainage records or information, existing CWD, etc. 

a. Designated Conservationist sends email notification to the 
SM.NRCS.IA.Compliance with “Request for Review of same file name as in 
396.5 (9)(a) above” in the subject line for independent technical review. 

3. SO Compliance staff retrieves referral from SM.NRCS.IA.Compliance shared email 
account. 

4. SO Compliance staff enters the request for review into the SO Internal SharePoint 
tracking spreadsheet. 

5. SO Compliance staff assigns Designated Conservationist in SO SharePoint tracking 
spreadsheet and notifies Designated Conservationist of the request for a review. 

a. SO Compliance staff forwards request for review documents to Designated 
Conservationist. 

6. Designated Conservationist conducts the request for review of the prior CWD 
according to current policy and procedures. 

a. If the Designated Conservationist does not concur as defined in NFSAM 
514.1(F)(2), the Designated Conservationist uses Exhibit 10 - Request for 
Review Denied Template Letter. Proceed to Step 7 unless reviewer concurs. 

b. If the Designated Conservationist concurs as defined in NFSAM 514.1(F)(2). 
i. Designated Conservationist drafts a decision notice letter with a summary of 

the review and recission of the existing CWD using ASTC-Compliance as 
the contact person. 

7. The Designated Conservationist organizes a digital copy of the review and places it in 
SharePoint under folder Compliance Internal\Compliance Editable Files\Request for 
Review. Note: Files include an updated CWD map, requested and signed Form NRCS-
CPA-026-WC in a PDF, a separate word file with the combination updated decision 
notice with recission letter, see Exhibit 11 – Request for Review Recission Template 
Letter and any other decision-making documents. Title 440, Part 510, Subpart C, 
Section 510.22(D). 

8. Designated Conservationist sends email notification of recommendation to the 
SM.NRCS.IA.Compliance with “Final Review of same file name as in 396.5 (9)(a) 
above” in the subject line for review by SO Compliance staff. 

9. SO Compliance staff reviews recommendation of Designated Conservationist. 
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10. SO Compliance staff forwards Form NRCS CPA-026-WC, CWD map, and Letter to 
SO Administrative staff for formatting. 

11. Decision Notice with recission of previous CWD and attachments are mailed from STC 
office. 

a. Decision notice with appeal rights completed for person requesting and all 
currently associated with the location. 

12. SO Administrative staff email decision notice/recission and attachments to SO 
Compliance staff, District Conservationist, CED, and assigned Designated 
Conservationist. 

13. SO Compliance staff enters the mailing date into the SO Compliance Internal 
SharePoint tracking spreadsheet. 

14. Additions or amendments to the agency record are saved in the respective 
F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 county folder directory and 
into CD Document Management.  

a. If there are existing documents in the 
F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 with signatures use 
Exhibit 4 - Instructions for Appending a PDF. 

396.8 Voluntary Mitigation Request 

1. Written request for voluntary mitigation by the participant received for either option 
onsite mitigation or utilizing a mitigation bank. 

2. FO staff or Designated Conservationist provides Exhibit 12 - Mitigation Checklist to 
participant, if onsite is the preferred mitigation method. 

a. Designated conservation will verify all associated with the tract consent to the 
proposed onsite mitigation request. 

3. FO staff or Designated Conservationist scans as double-sided, in color, the written 
request and all CWD relevant documents to the request including but not limited to, 
mitigation request, any tile records, previously CWD, etc. 

a. Sends email notification to the SM.NRCS.IA.Compliance with “Voluntary 
Mitigation of same file name as in 396.5 (9)(a) above” in the subject line. 

4. SO Compliance staff retrieves referral from SM.NRCS.IA.Compliance. 
5. SO Compliance staff enters the request for Voluntary Mitigation into the SO Internal 

SharePoint tracking spreadsheet. 
6. SO Compliance staff assigns Designated Conservationist with appropriate JAA in SO 

SharePoint tracking spreadsheet and notifies Designated Conservationist with JAA 
level 2 or 3 of the request via email. 

7. Designated Conservationist discusses and reviews Exhibit 12 - Mitigation Checklist 
or Mitigation Bank application with participant as per NFSAM 515.11(B). 

a. Notify the participant that voluntary mitigation is for FSA purposes only, other 
agencies would need to be notified by the participant. 

8. Designated Conservationist works with participant to complete steps outlined in 
NFSAM 515.10 (C), and NFSAM 515.12 (A) for the Mitigation Plan.  

9. Designated Conservationist conducts onsite FA of the proposed mitigation area 
referring to Exhibit 13 - FA Guide. 

a. Designated Conservationist sends email notification of recommendation to the  
SM.NRCS.IA.Compliance with “Mitigation FA of same file name as in 396.5 
(9)(a) above” in the subject line for review by SO Compliance staff. 

b. SO Compliance staff reviews FA and Voluntary Mitigation Request with 
Designated Conservationist.   

10. Designated Conservationist sends/delivers the approved FA as a single PDF to the 
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participant. 
11. Participant continues with Exhibit 12 - Mitigation Checklist or purchases mitigation 

credits. 
12. Participant delivers completed Mitigation Agreement and/or Plan as appropriate to 

Designated Conservationist. Note: Mitigation Bank will contact ASTC-Compliance 
with approved mitigation credit purchase by requesting participant. 

13. ASTC-Compliance will contact appropriate Designated Conservationist to update 
CWD map, Form NRCS CPA-026-WC, and appropriate letter (See step 15 below). 

14. Designated Conservationist updates maps with new mitigation exemption label(s) once 
mitigation is completed or receives confirmation from the mitigation bank that credits 
have been purchased. 

15. Designated Conservationist emails the updated CWD map, updated Form NRCS CPA-
026-WC, and Voluntary Mitigation Letter (use Exhibit 14A or 14B based on 
scenario) as a Mitigation Packet to CSS with a carbon copy to SO Compliance staff.  

16. CSS mails out Mitigation Packet to respective person(s) as listed on the Producer Farm 
Data Report, District Conservationist, and FSA CED. 

17. All Mitigation Documents including FA are added or amended to the agency record 
and saved in the respective F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 
county folder directory and into CD Document Management.  

a. If there are existing documents in the 
F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 with signatures use 
Exhibit 4 - Instructions for Appending a PDF. 

18. SO puts completion mitigation dates in the SO tracking SharePoint spreadsheet. 
19. SO ensures mitigation documents are entered into National Easement Staging Tool. 

396.9 Participant Request for Scope and Effect (NFSAM 510.11(E)) or 
Lateral Effect 

1. FO receives written request, may use Exhibit 15 – IA WC Technical Assistance 
Request, from participant for Lateral Effect and/or Scope and Effect (NFSAM 516.11). 
Note: FO gathers additional information from participant on intended activities. This 
information will include size, depth, grade, placement, and proximity of drainage 
proposal. 

2. FO forwards written request for technical assistance to the local agency expert with 
appropriate JAA (see FOTG Section 3 Legislated Programs JAA Roster). 

a. If not Level 3 on JAA Roster, FO sends to local Wetland Designated 
Conservationist. 

3. Agency Expert with Level 3 JAA completes request and recommendation according to 
IA180-516-M, 5th Ed., Amend. 3, Apr 2018. 

a. If Level 2 or lower, Designated Conservationists completes request and emails 
Level 3 JAA Agency Expert or SO Compliance staff for review. 

4. Level 3 JAA Agency Expert or SO Compliance staff forwards the lateral/scope and 
effect recommendation to the CSS for mailing. 

5. CSS mails to the participant and emails a copy to the District Conservationist. 
6. All Scope and Effect and Lateral Effect Documents are added or amended to the agency 

record and saved in the respective F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-
026 county folder directory and into CD Document Management.  

a. If there are existing documents in the 
F:\DATA\IA<firstthreelettersofoffice>\NRCS-CPA-026 with signatures use 
Exhibit 4 - Instructions for Appending a PDF. 
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396.10 Responsibilities 

Iowa NRCS staff, Partners, and Contractors must follow this Iowa Instruction upon receipt of 
each compliance request(s). HELC/WC determinations will be completed only as assigned in 
396.5. 
 

396.11 Exhibits 

Exhibit 1 - Existing Wetland Determination Template Letter 
Exhibit 2 - Iowa NRCS HELC Tool for ArcMap User Guide 
Exhibit 3 - CD Document Management Uploading Guidance 
Exhibit 4 - Instructions for Appending a PDF  
Exhibit 5 - Certified Mail Return Receipt Guidance 
Exhibit 6 - Appeal Acknowledgement Template Letter  
Exhibit 7 - 6 Part Folder Cover Sheet Guidance 
Exhibit 8 – Form NRCS-CPA-17 for HELC 
Exhibit 9 - Request for Review 
Exhibit 10 - Request for Review Denied Template Letter 
Exhibit 11 - Request for Review Recission Template Letter 
Exhibit 12 - Mitigation Checklist 
Exhibit 13 - FA Guide 
Exhibit 14A - Voluntary Mitigation Letter Template – Wetland Restoration Agreement 
Exhibit 14B – Voluntary Mitigation Letter Template – Mitigation Bank 
Exhibit 15 - IA WC Technical Assistance Request 
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NRCS HEL Tool for ArcMap: User Guide 
Gregg Hadish, USDA Natural Resources Conservation Service, Des Moines, Iowa 

 

One-time Preparation Steps 
1. Before opening ArcMap, open File Manager navigate to F:\ArcMap_Tools. 
2. Right-click the HEL folder and choose Copy. 
3. Open C:\ArcMap_Tools, right-click and choose Paste. 

 

ArcMap Steps 
1. From C:\ArcMap_Tools\HEL, open the ArcMap project HEL_Template.mxd 

 

3. From the Selection menu, click Select By Attributes. From the Layer pull-down choose the 
County Common Land Units, in the select box enter "TRACTNBR" = 9622 (the tract specified in 
the AD-1026). If a field is specified in the AD-1026, enter "TRACTNBR" = 9622 AND "CLUNBR" =1 
and click OK. 
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4. Use Selection > Zoom to Selected Features; verify that the correct tract and or fields match 
those specified in the AD-1026. The HEL Soil Class layer shows the HEL, PHEL, and NHEL map 
units. Uncheck the HEL Soil Class layer and check on the PLSS Township, Section Lines, and 
Orthophoto layers. 
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5. Open the ArcToolBox window and expand the --NRCS HEL Determination toolbox. Double- 
click NRCS HEL Determination Tool. 

 

6. From the pull-downs choose the CLU, HEL, and DEM layers. Enter the District Conservationist 
and Customer Names. Select OK. A status box will open, when Completed, click Close. (A 
Microsoft Access window will open). 
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7. A new Field Determination and Initial HEL Summary map layer are added to the ArcMap view. 
Each Field is labeled with the HEL determination; the HEL Summary soils layer indicates the 
percentage of HEL and NHEL soils within each field. Turn off the Initial HEL Summary layer. 

 

8. Open the Layout View; enter the Location, Assisted by, and Service Center information. Select 
File > Export Map, Save in: C:\Temp, File name: HEL_Template, file type: PDF > click Save. 
Repeat this step to save a soil map by turning on the HEL Summary layer in the map view. 
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Microsoft Access Steps 
1. From the Main Switchboard, click Open CPA-026e Form. Enter the Client Address, and Request 

Date. In the table section set the Sodbust to Yes or No (based on information from the AD- 
1026). Click the Save and Open CPA-026e button, save the PDF file using the default name to 
the C:\temp folder. Click Close Form. 

 

 
2. From the Main Switchboard Select Client HEL Summary. Click the PDF or XPS button, save the 

PDF file using the default name to the C:\temp folder, click Publish. If prompted Close the Save 
Export Steps window. 

 

3. From the Main Switchboard Select Client Letter. Click the PDF or XPS button, save the PDF file 
using the default name to the C:\temp folder, click Publish. 

 
4. From the Main Switchboard Select Planner Map Unit Summary report. Click the PDF or XPS 

button, save the PDF file using the default name to the C:\temp folder, click Publish. 
 

5. Click Exit Access. (Note: the information for the HEL Determination is not saved in Access, it is 
cleared for the next run of the HEL Tool). 
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Adobe Acrobat Steps 
1. In File Explorer open the C:\Temp folder, sort the files by Date Modified. The newly created PDF 

files will appear at the top of the list. Select the five PDF files, Right-click and choose Combine 
files in Acrobat. 

 

2. Click the Combine button. 
 

 

3. From the tool bar select the Organize Pages tool.  Click and drag the 
pages into order: cover letter > CPA-026 > map > and summary reports. Click the Save button, 
open F:\NRCS-CPA-026, save the file using IAFIPS_F000_T000.pdf (e.g., IA001_F6240_T9622); 
the list of Iowa FIPS codes is included on the last page of this document. If this file already exists, 
save it with a (2) at the end of the file name; see step 5 below for merging pages from two PDFs. 
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4. Print the necessary pages from the saved PDF to mail to the Customer. 
5. Merging pages from two PDF documents. 

a. Open both of the documents in Adobe Acrobat; select Window > Tile > Vertically. This 
will open the PDFs side-by-side. 

 

 

b. Select the Organize pages tool on both documents. 
 

c. Click and drag the pages from one document to the other to create one complete 
document. Place the pages with the most recent dates at the top. Use Edit > Select All, 
to drag all of the page at once. 



 
Iowa Instruction 180-396, 2nd Ed. 

 
Exhibit 2 

 

(IA180-396-IAI, 2nd Ed., Dec 2021) 
Page 8 of 11 

 
 

d. Select the Save File button to save the changes in the completed document. 
 

e. After you have saved the changes to complete PDF, delete the extra document that you 
copied pages from; use right-click > Delete. Be sure that the final completed PDF follows 
the IA000_F_T.pdf naming convention. 
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CODE COUNTY 

IA001 ADAIR 

IA003 ADAMS 

IA005 ALLAMAKEE 

IA007 APPANOOSE 

IA009 AUDUBON 

IA011 BENTON 

IA013 BLACK HAWK 

IA015 BOONE 

IA017 BREMER 

IA019 BUCHANAN 

IA021 BUENA VISTA 

IA023 BUTLER 

IA025 CALHOUN 

IA027 CARROLL 

IA029 CASS 

IA031 CEDAR 

IA033 CERRO GORDO 

IA035 CHEROKEE 

IA037 CHICKASAW 

IA039 CLARKE 

IA041 CLAY 

IA043 CLAYTON 

IA045 CLINTON 

IA047 CRAWFORD 

IA049 DALLAS 

IA051 DAVIS 

IA053 DECATUR 

IA055 DELAWARE 

IA057 DES MOINES 

IA059 DICKINSON 

IA061 DUBUQUE 

IA063 EMMET 

IA065 FAYETTE 

IA067 FLOYD 

IA069 FRANKLIN 

IA071 FREMONT 

IA073 GREENE 

IA075 GRUNDY 

IA077 GUTHRIE 

IA079 HAMILTON 
 

IA081 HANCOCK 

IA083 HARDIN 

IA085 HARRISON 

IA087 HENRY 

IA089 HOWARD 

IA091 HUMBOLDT 

IA093 IDA 

IA095 IOWA 

IA097 JACKSON 

IA099 JASPER 

IA101 JEFFERSON 

IA103 JOHNSON 

IA105 JONES 

IA107 KEOKUK 

IA109 KOSSUTH 

IA111 LEE 

IA113 LINN 

IA115 LOUISA 

IA117 LUCAS 

IA119 LYON 

IA121 MADISON 

IA123 MAHASKA 

IA125 MARION 

IA127 MARSHALL 

IA129 MILLS 

IA131 MITCHELL 

IA133 MONONA 

IA135 MONROE 

IA137 MONTGOMERY 

IA139 MUSCATINE 

IA141 O'BRIEN 

IA143 OSCEOLA 

IA145 PAGE 

IA147 PALO ALTO 

IA149 PLYMOUTH 

IA151 POCAHONTAS 

IA153 POLK 

IA155 POTTAWATTAMIE EAST 

IA156 POTTAWATTAMIE WEST 

IA157 POWESHIEK 

IA159 RINGGOLD 
 

IA161 SAC 

IA163 SCOTT 

IA165 SHELBY 

IA167 SIOUX 

IA169 STORY 

IA171 TAMA 

IA173 TAYLOR 

IA175 UNION 

IA177 VAN BUREN 

IA179 WAPELLO 

IA181 WARREN 

IA183 WASHINGTON 

IA185 WAYNE 

IA187 WEBSTER 

IA189 WINNEBAGO 

IA191 WINNESHIEK 

IA193 WOODBURY 

IA195 WORTH 

IA197 WRIGHT 
 

Admin County Codes of Iowa USDA Service Centers 
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 CD Documents Management Uploading Guidance For Official Use Only 
 

To upload HELC and WC documents: 
 

1. From the HELC/WC Search Results, click on the vertical ellipsis in the Actions column and 

select Manage Documents. 
 

 
A Document Management screen presents views, documentation details and document-related 
functions for the request. Click the Upload New Document to select a document to upload. 

 
Naming Conventions 

 

Documents Category Document Name Documentation Type 
AD-1026 Request HELC IAFIPS_FXXXX_TXXXX_HELC AD-1026 Packet 
AD-1026 Request WC IAFIPS_FXXXX_TXXXX_WC AD-1026 Packet 

CPA-038 Request-WC IAFIPS_FXXXX_TXXXXX_038 CPA-038 Packet 

FSA-569-Request-WC IAFIPS_FXXXX_TXXXX_569 FSA-569 Packet 

AD-1026 Info Only-WC IAFIPS_FXXXX_TXXXX_IOWC AD-1026 Packet 

Previously Certified Determination -WC IAFIPS_FXXXX_TXXXX _PCWD Previous CWD 

Other-HELC IAFIPS_FXXXX_TXXXX_HELC ALL HELC Documentation 

Other- WC IAFIPS_FXXXX_TXXXX_WC All WC Documentation 

FSA-569 Response-WC IAFIPS_FXXXX_TXXXX_569 All 569 Documentation WC 

Supporting Tech Doc Preliminary- HELC IAFIPS_FXXXX_TXXXX_PHELC Appeal Information 

Supporting Tech Doc-Final -HELC IAFIPS_FXXXX_TXXXX_FHELC Final Appeal Documents 

Supporting Tech Doc Preliminary-WC IAFIPS_FXXXX_TXXXX_PWC Appeal Information 

Supporting Tech Doc Final-WC IAFIPS_FXXXX_TXXXX_FWC Final Appeal Documents 

Assistance Notes-HELC IAFIPS_FXXXX_TXXXX_AN_HELC CPA-06 Notes 

Assistance Notes-WC IAFIPS_FXXXX_TXXXX_AN_WC CPA-06 Notes 

Correspondence Determination Final IAFIPS_FXXXX_TXXXX_CDFHELC HELC Final Letter & forms 

Correspondence Determination Final WC IAFIPS_FXXXX_TXXXX_CDFWC WC Final Letter & forms 

Combined Client Product Final -HELC IAFIPS_FXXXX_TXXXX_CCPFHELC Client can access this file 

Combined Client Product Final-WC IAFIPS_FXXXX_TXXXX_CCPFWC Client can access this file 
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2. Provide Document Category and Document Type in the Upload New Document modal window. 
Then, click the Choose File button to select a file to upload. 

 

3. Provide an optional Document Title and Comments. Then, choose UPLOAD to upload the 
document or CANCEL to return to the Document Management screen. 

 

Should the upload process encounter an error, as in the example of a duplicate document 
below, a warning modal will present the error type. In the case of a duplicate document, a 
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Note: Closing a request simply removes it from the Table of Contents and does not affect the request 
status. 

Continue and Overwrite radio button will be provided to allow the upload to overwrite an 
existing document. Select Continue and Overwrite and UPLOAD to continue; RETURN TO 
UPLOAD FORM to return to select different upload options; or CANCEL to return to the 
Document Management screen. 

 

4. A successful upload is indicated by a system message that the top of the Document 
Management screen and the addition of the new document details in the Document 
Management grid as seen below. 

 

 
 

To Close a Request: 

 
 

1. Select Close Request from the HELC/WC Panel. 
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Iowa Wetland Compliance Technical Assistance Request 
 
PARTICIPANT INFORMATION 

 
LANDOWNER INFORMATION 

Name  Name 

Address  Address 

City, State ZIP  City, State ZIP 

Phone  Phone 

Email  Email 

Farm/Tract Number  Proposed start date 

Legal Description Section T R County 

SCOPE OF PROPOSED ACTIVITIES Is a certified wetland determination completed? circle one  Y N 

  

  

  

SUMMARY OF PRE 12-23-1985 DRAINAGE or 
WOODY VEGETATION ( ALL YEARS PRESENT) 

Attach map showing approximate locations as referenced below 

  

  

  

WHAT TECHNICAL ASSISTANCE ARE YOU REQUESTING?  Circle below all that apply 

SCOPE AND EFFECT MINIMAL EFFECT WETLAND   BOUNDARY   FLAGGING 

Lateral Effect Request for Review Functional Assessments Mitigation Plan 

USDA Program Participant 
 

Date 

Landowner  Date 

NRCS AGENCY EXPERT ASSIGNED FILLED OUT BY NRCS 

AGENCY EXPERT:  TITLE: 

   
 

 

  Verified by ASTC-Compliance 
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REQUESTS FOR TECHNICAL ASSISTANCE FOR WETLAND COMPLIANCE WITH 
THE FOOD SECURITY ACT AS AMENDED 

 
A person that applies for USDA benefits is responsible for obtaining wetland determinations, 
exemptions, and scope and effect evaluations before altering any wetland area, improving an 
existing drainage system, or maintaining an existing drainage system. Title 180, National 
Food Security Act Manual (NFSAM) Section 510.11 (E) 

 
USDA participants are not required to request permission and/or an onsite evaluation of their 
maintenance plans. USDA participants should exercise caution when maintaining drainage 
systems so that neighboring wetlands are not inadvertently drained. A participant may request an 
onsite evaluation. NFSAM Section 516.12 (C) 

 
Scope and Effect 

 
To assist in scope and effect evaluations, the USDA participant is responsible for providing 
records and plans for any past hydrologic manipulations, and furnishing plans for any proposed 
manipulations, including the drainage capacity of existing and planned drainage systems. The 
participant is also responsible for complying with all federal, state, or local regulations, permits, 
etc., administered by other agencies. NFSAM Section 510.11 (E) 

 
NRCS responsibilities include determining whether maintenance of existing drainage exceeds 
scope and effect of the original drainage. NFSAM Section 510.20 (C) 

 
Scope and effect refers to the documentation of wetland hydrologic conditions and manipulation 
that occurred before December 23, 1985, or planned hydrologic manipulation on these previously 
manipulated wetlands (7 CFR Section 12.6(c)(2)(B)(xi)). A scope and effect evaluation will help 
determine if an action can be considered maintenance, or if it is an improvement of an existing 
drainage or water control system. NFSAM Section 516.10 (A) 

 
Lateral Effect 

 
Lateral effect estimates can be performed by NRCS for planned drainage activities on new and 
improved systems. NRCS will use guidance NRCS Estimate of Lateral Effect for Constructed 
Drainage Features in Agricultural Fields for use in wetland determinations under the USDA Farm 
Bill. A field visit may be required. Additional information may be provided by using Wisconsin 
Job Sheet 823 

 
Minimal Effect 

 
A minimal effect evaluation will be conducted when a USDA participant requests a minimal effect 
exemption in writing [7 CFR Section 12.31(d)]. The minimal effect evaluation includes an 
assessment of the functional level of the wetland before project impacts, and an assessment of 
functional level after project completion. The functional assessment component of the evaluation  
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will be based on site conditions and must be documented using approved functional assessment 
worksheets. The USDA participant must provide NRCS with the following information before the 
required site visit:  
 

• Description of the proposed activity  
• Location of the proposed activity and  
• Any existing restrictions on the property in question, such as easements or permit 

conditions. NFSAM Section 515.1 (B) 
 
If a person has converted a wetland and then seeks a determination where the effect of such 
conversion on wetland was minimal, the burden will be upon the person to demonstrate to the 
satisfaction of NRCS the effect was minimal [7 CFR Section 12.31 (d)]. 
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Instruction for Appending a PDF 
 
Here are the steps for retaining the digital signature in a PDF that is being edited or merged with another PDF. 
Please forward to the wetland specialists. 
 
When editing or merging NRCS-CPA-026 PDFs that contain a digital signature, a blue signature panel will 
appear at the top of the Adobe Acrobat window. In order to retain the digital signature box, complete the 
following steps before editing or merging: 
 

a. Select File > Print  
b. For the Printer choose Microsoft Print to PDF, click Print. 
c. For the file name use the existing file name with an added “_B” e.g., 

IA027_F8707_T7182_B, click Save.  
d. Open the newly saved PDF and edit or merge as needed.  
e. Remove the original PDF, and then rename the newly edited one by removing the “_B” from 

the file name. 
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Farm Production  
and 
Conservation 

Natural Resources 
Conservation  
Service 

 
Insert FO Address 
City, IA  Zip 
Voice (XXX) XXX-XXXX 
FAX (XXX) XXX-XXXX 

  

USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

Insert date here (2 returns) 
 
Participant Name 
Address 
City, State Zip Code (2 returns) 
 
RE:  Acknowledge Receipt of Reconsideration Request, Farm #****, Tract #****, in *** 
County, IA (3 returns) 
 
 
Dear Participant: (2 returns) 
 
This letter is to acknowledge your request for a field visit and reconsideration of the preliminary 
[choose Highly Erodible Land Compliance (HELC) or Wetland Compliance (WC)] 
determination [insert determination decision e.g., Showing 2.5 acres of Wetland] on Field #***, 
Tract #***, Farm #*** in *** County, IA. 
 
The NRCS will review your reconsideration request on [insert date and time] at your farm, as 
agreed upon [call and verify the time prior to sending the letter]. You, your authorized 
representative, or both are invited to be present during the field review and may submit any 
additional information in support of your request. 
 
If you are unable to participate in the field review, you may submit any information within  
15 calendar days of the date of this letter to the NRCS office located at: *** Local NRCS Field 
Office Address*** or email Designated Conservationist@usda.gov. 
 
The NRCS will consider all information gathered or presented during the field review and will 
arrive at the agency’s final technical determination based on all applicable compliance 
procedures. 
 
The final determination will be sent to you as soon as possible following the field review. If you 
have any questions regarding this matter, you may contact Your Name, Wetland Specialist, at 
(XXX) XXX-XXXX ext. X or by email at Your.Name@usda.gov. 
 
Sincerely, (4-5 returns) 
 
 
 
 
Your Name 
Designated Conservationist 
 

mailto:Your.Name@usda.gov
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Certified Mail - Return Receipt Guidance 
 

• Adverse Compliance Decisions are to be sent Certified Mail - Return Receipt. 
• Write the Tract # and County Number on the Certified Mail - Return Receipt (Sample 

images related to certified-receipt mailing are below). 
• Certified Mail - Return Receipts are to be put in the customer file once it is returned. 
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6 Part folder Cover Sheet Guidance 
DOCUMENTATION ORGANIZATION of AGENCY RECORD for INFORMAL TECHNICAL APPEAL 

Organization is for use of a 6 part folder or as independent digital files containing all information in the order below 
 

COUNTY: _______________________ TRACT# __________   NRCS Review (Reconsideration)    FSA Appeal Review  

 
This casefile contains all the data that was used for this determination ______________________ (Designated Conservationist) 
 
SECTION I. Notes – all placed newest to oldest as one set 

1. Index/Check List- 6 part folder cover sheet guidance 
2. Chronological History 
3. Current NRCS-CPA-026e and Certified Determination map,  
4. CPA-026’s/026e’s, PTD maps, and determination letters for previous determinations including uncertified determination. 

There should be documents for the person who signed AD-1026 and all persons listed on the 156EZ, the FSA-569, or the 
producer data report. 

5. All FSA-569’s – current 569 Must be in the file before sending a decision of CW+year 
6. All Technical Assistance Notes, Conservation Planning Notes, and meeting notes related to all determinations 

 
 

SECTION II. All Communication – all placed in chronological order from newest on top to oldest on bottom as one set 
1. Letters from appellant to NRCS and FSA  
2. Any letters of acknowledgment  
3. Preliminary Technical Determination letter from NRCS with Postal Certified mail receipt and mailing information showing 

dates and signatures 
4. Reconsideration notes (if applicable) – Who was present? What was discussed including any additional information provided 

by Owner/Operator? When meeting occurred? Where meeting took place (must be at the wetland)? 
5. Draft Final Technical Determination letter from NRCS with Postal Certified mail receipt and mailing information showing 

dates and signatures 
6. Letter from FSA granting or denying Good Faith Exemption 
7. Request from FSA to conduct a review of the Final Technical Determination 
8. Trip report of Field Visit (required when FSA requests review of determination by State Conservationist) 

 
 
SECTION III. All data documentation; SOSM printouts, Agriculture Datasheets, COE forms, etc. 

1. Base Map with Sampling Units, Size, and Representative Observation Points (ROP) identified  
2. All on-site and/or off-site data sheets – as appropriate 
3. Climate Data spreadsheet if on-site methods used 
4. All SOSM documentation – if appropriate 
5. Soil map with legend 
6. Hydric Soils list 
7. LiDAR map – if SOSM process used 
8. Other data used, and data forms used 

 
SECTION IV. Reference Material 

1. GPS Data 
2. Site Map, NWI map  
3. Engineering notes including historical data 
4. Official Soils Series Description 
5. Tile maps or other drainage information – include imagery that indicate drainage activity 
6. Photographs 
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SECTION V. Remote Imagery 

1. Sampling Unit imagery 
a. If Reconsideration is requested, include copy of imagery used to make Preliminary Determination 

2. Imagery Documentation – spreadsheet indicating which years are Normal, Dry, and Wet along with the rainfall station used 
3. Land use imagery – 

A. 1985 and/or 1986  
B. 1990 and/or 1991 if pertinent 
C. Year before and after any conversion activity 

4. Other imagery of note 
A. Signatures of drainage 
B. Signatures of manipulation, but not conversion 

 
 
SECTION VI. Minimal Effect Documents 

 Copy of Functional Assessment worksheets 
 Iowa Minimal Effect decision worksheet  

 
 
Note for Technical Reconsiderations:  
• Reconsideration is only for area(s) being appealed. Do not analyze other areas unless they are involved in a boundary change. 
• Locally provided information is to be placed in the appropriate section e.g. imagery-sec.V, tile maps-sec.IV, 
• File is not complete without a detailed report of the reconsideration meeting that occurs after the request is made. 
• File information should be assembled in the order above by the Designated Conservationist and forwarded to the ARC for review 

before sending to the State Office. 
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U.S. Department of Agriculture  
Natural Resources Conservation Service  

NRCS-CPA-17  
(Rev. 6/2012)  

 
ADMINISTRATIVE RECORD  

DOCUMENT INDEX  
CONSERVATION COMPLIANCE  

NAME (APPELLANT):  TRACT NO.:  
COUNTY:  STATE:  
 
SECTION 1:  Forms  
A.  Chronology of Events  
B.  Administrative Record Checklist  
C.  AD-1026(s) and AD-1026U(s) – All years pertinent to the appeal  
D.  NRCS-CPA-026 and NRCS-CPA-026A (with attached dated photo w/HEL designations) 

& HEL Calculations  worksheet 
E. ASCS-569 - required prior to sending any adverse decision 
 
SECTION II.  Letters of Appeal from “Appellant” followed by Letters of Determination from NRCS 
in Chronological order – newest on top. (Include Field notes from each level.)  
A. 1st Level  
B. 2nd Level  
C. 3rd Level  
D. 4th Level 
 
SECTION III.  Maps and Soils Information  
A.  Soils map and legend with area in question clearly identified  

Name and acres of each HEL and NHEL map unit by field – ArcMap summary 
B.  County Highly Erodible Land Soils list  
C. Onsite examination report of HEL criteria and soils, including documentation of PHEL  
 
SECTION IV.  Conservation Plan and Schedule of Application  
A.  Conservation Plan  
B.  Plan maps with area in question clearly identified and outlined in color  
  
SECTION V.  NRCS Supporting Data  
A.  RUSLE2 Profile sheets for current system and ACS system for each field or similar soil 

map unit 
B. 

 
Field Documentation sheet(s), maps with residue locations, photos with GPS points, 
field notes, crop history, other documentation 

 
SECTION VI.  Other Supporting Data  
A.  NRCS-CPA-15 Conservation Assistance Notes  
B.  Reconsideration (field visit) Meeting Records and Notes – dated and signed by producer 

if present for field visit, Include GPS located photo of NRCS staff in the field 
C. Data-Provided by Landowner/Operator 
D.  Records of hearings including persons present, data prescribed, and decisions reached  
E.  Other correspondence  
F.  SWCD comments  
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REQUEST FOR REVIEW OF FINAL CERTIFIED 
WETLAND DETERMINATION 

 
 
TO: NRCS 
 
RE: Wetland Review 
 
Tract # _________________,        Farm #_______________________, 
 
 located in __________________ County. 
 
 
I, ________________________________, am requesting a review of the Final Certified  
      (your name) 
Wetland Determination dated,____________________ ,for the reason(s) described  
below: 
 
                                     

 
 

⁫Natural Disaster 
(explain)________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________ 
 
 
 

⁫NRCS made an error  
(explain)________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________ 
 
 
 
 
___________________________________   ________________________ 
Owner or Operator’s signature Date 



  
Farm Production  
and 
Conservation 

Natural Resources 
Conservation  
Service 

 
Insert FO Address 
City, IA  Zip 
Voice (XXX) XXX-XXXX 
FAX (XXX) XXX-XXXX 

  

USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

 
Insert date here (2 returns) 
 
Name of Participant 
Address  
City, State Zip (3 returns) 
 
 
Dear Participant Name: (2 returns) 
 
On <date>, you requested a review of a Certified Wetland Determination for land located in the 
*** of Section *** of “Twp-Range-Sec” on Tract #***, Farm #***, *** County, Iowa.  
 
Pursuant to the National Food Security Act Manual Section 514.1 C (2), Title 7 of the Code of 
Federal Regulations (CFR) Section 12.30(c) (6) and 16 U.S.C. Section 3822(a) (4), a person may 
request review of a final certified wetland determination when either of the following apply: 
 
1) A natural event alters the topography or hydrology of the subject land to the extent that 
the final certification is no longer a reliable indication of site conditions, or  
 
2) If NRCS concurs with an affected person that an error exists in the current wetland 
determination. 
 
Based on the information that you have provided, no error exists, and no topographic or 
hydrologic change has occurred on your property. Therefore, NRCS denies your request to 
review your existing wetland determination. The existing final certified wetland determination 
will remain in effect. 
 
This decision to not conduct a review does not change the existing wetland determination for 
Tract # and therefore is not appealable.  
 
If you disagree with the decision to deny appeal rights, you may request a review from the 
Director of the National Appeals Division (NAD). Your request must be in writing and state the 
reason that you believe the decision is in error.  
 
 
Please submit your request to NAD within 30 calendar days from receipt of this letter at the 
following address: 
 
 Director  
 USDA, National Appeals Division 
 3102 Park Center Drive, Suite 1100 
 Alexandria, Virginia 22302 
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You must also send a copy of your request to NAD to NRCS at the following address: 
 
 Derrick Klimesh 
 Assistant State Conservationist - Compliance 
 210 Walnut Street, Room 693 
 Des Moines, IA 50309-2180 
 
You have 30 calendar days from the date of receipt of this letter to make any request as outlined 
above. Please contact me if you have any questions at Your.Name@usda.gov or by telephone 
(XXX) XXX-XXXX. 
 
Sincerely, (4-5 returns) 
 
 
 
 
Your Name  
Designated Conservationist 
 
cc: Derrick Klimesh, Assistant State Conservationist – Compliance, NRCS, Des Moines, IA 
 Name, District Conservationist, NRCS, City, State 
 Name, County Executive Director, FSA, City, State 
 All others associated with the tract, Full Address, City, State 
 

mailto:Your.Name@usda.gov


 Farm 
Production 
and 
Conservation 

Natural Resources 
Conservation 
Service 

 
Insert FO Address 
City, IA Zip 
Voice (XXX) XXX-XXXX 
FAX (XXX) XXX-XXXX 

 
 

     

USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

CERTIFIED MAIL--RETURN RECEIPT REQUESTED 
 
Insert date here (2 returns) 
 
Participant Name Requesting Review (Make sure they are on the 156ez) 
Address 
City, State Zip Code (3 returns) 
 
 
Dear Participant Name: (If this is an entity, need contact name here) (2 returns) 
 
On Enter Date, you requested the Natural Resources Conservation Service (NRCS) review a Certified 
Wetland Determination (CWD) dated Enter Date, for land located in Section *** of “Twp-Range-Sec,” on 
Tract #***, *** County, Iowa.  
 
Pursuant to the National Food Security Act Manual (NFSAM) Section 514.1 C (2), Title 7 of the Code of 
Federal Regulations (CFR) Section 12.30(c) (6) and 16 U.S.C. Section 3822(a) (4), a person may request 
review of a final certified wetland determination when either of the following apply: 
 
1) A natural event alters the topography or hydrology of the subject land to the extent that the final 

certification is no longer a reliable indication of site conditions, or  
2) If NRCS concurs with an affected person that an error exists in the current wetland determination.  
 
In your request you state you believe NRCS erred in the determination because of existing drainage tile in 
the area that was not considered at the time of the wetland determination. A review of an existing certified 
wetland determination may be done if NRCS concurs that an error exists in the current determination. On 
Enter Date, an NRCS Wetland Specialist completed a review of these sites. Based on this review, NRCS 
determined that an error exists with the Certified Wetland Determination dated Enter Date. Drainage tile 
installed prior to December 23, 1985, was verified and considered on the areas previously designated as 
wetlands. The new certified wetland determination will now classify the area requested as Prior Converted 
cropland.  
 
I am hereby rescinding the Final Technical Determination dated Enter Date, based on the following error: 
consideration was not given for existing tile drainage systems installed prior to December 23, 1985; the 
best-drained condition of the sites resulting from the installation of this drainage was not identified. 
 
Enclosed is a Preliminary Technical Determination with the wetlands being changed to prior converted 
cropland. See the enclosed NRCS-CPA-026-WC “Highly Erodible Land and Wetland Conservation 
Determination” form and map for definitions and location(s) of wetlands on this tract. If you did not 
request a wetland determination for your entire farm, wetlands may exist in other locations. The enclosed 
wetland determination map reflects the wetland delineation(s) that have changed but also may show other 
wetland locations which have not been modified. Only the wetland(s) which have changed are identified on 
the NRCS-CPA-026-WC with a current determination/certification date and only these wetlands are subject 
to appeal as detailed below.  
 
If you do not consider this decision to be adverse, no further action is required on your part. This 
preliminary determination will become final 30 days after receipt of this letter.  
 
If you disagree with this decision, you may appeal this decision by requesting one of the options listed 
below. Your request for one of the following options must be made within 30 days of receipt of this 
letter.  
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USDA is an equal opportunity provider, employer, and lender. 

 
1. A reconsideration and field visit. During the field visit we will review the basis for our preliminary 

converted wetland determination, answer any questions you have regarding this preliminary 
determination, and offer an opportunity for you to provide additional information regarding this 
determination. 

 
2. Request mediation by contacting the Iowa Mediation Service at the address below. Mediation may be 

used in an attempt to settle your concerns with this preliminary converted wetland determination. 
 
 Iowa Mediation Service 
 1441 29th Street, Suite 120 
 West Des Moines, IA 50266 
 (515) 331-8081 
 
If you choose to use mediation, the Natural Resources Conservation Service (NRCS) will pay up to one-
half of the costs that are appropriate and reasonable which are associated with securing the services of a 
trained mediator when the services are provided on other than a voluntary basis. The NRCS will have final 
discretion over what is considered appropriate and reasonable. 
 
3. You may waive your rights to mediation and a field review of the preliminary technical determination. 
This request must be in writing and addressed to Jon Hubbert, State Conservationist, 210 Walnut Street,  
Room 693, Des Moines, IA 50309. In this case you will immediately be issued a final technical determination 
and appeal rights to National Appeals Division (NAD) and/or to the FSA County Committee. 
 
After completion of the field visit if one is requested, or following the completion of mediation, a final 
technical determination will be issued. If you choose to take no action, the Preliminary Technical 
Determination will become the Final Technical Determination 30 days after receiving this notice. Once 
this determination becomes Final, you may appeal to the FSA County Committee, or to the National 
Appeals Division (NAD), at the addresses listed below within 60 calendar days from the date of receipt of 
this notice. 
 
 Local FSA County Committee 
 Address 
 City, IA Zip Code 
 
 Or 
 
 USDA, National Appeals Division 
 Eastern Regional Office 
 P.O. Box 68806 
 Indianapolis, IN 46268 
 Telephone: (800) 541-0457 
 Facsimile: (317) 875-9674 
 https://www.nad.usda.gov/ 
 
In order to maintain your eligibility for USDA program benefits, contact your local NRCS office prior to 
performing any land altering activities (tiling, land clearing, ditching, drainage maintenance, filling, 
leveling, removal of woody vegetation, or dredging,) in or adjacent to the identified Wetland (W), Farmed 
Wetland (FW), Farmed Wetland Pasture or Hayland (FWP), or Not Inventoried area(s). 
 
  

https://www.nad.usda.gov/
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USDA is an equal opportunity provider, employer, and lender. 

 
The 2014 Farm Bill connected producer eligibility for Federal crop insurance premium subsidy to 
compliance with the wetland conservation provisions. Eligibility for most USDA programs is lost for any 
wetland conversions that have occurred after December 23, 1985. However, only wetland conversions that 
occur after February 7, 2014, result in ineligibility for Federal crop insurance premium subsidy. 
 
This certified wetland determination is conducted for the purpose of implementing the Food Security Act of 
1985, as amended. This determination may not be valid for identifying the extent of the United States Army 
Corps of Engineers (COE) Clean Water Act jurisdiction for this site.  If you intend to conduct any activity 
that constitutes a discharge of dredged or fill material into wetlands or other waters of the United States 
including lakes, rivers, intermittent or perennial streams, you should request a jurisdictional determination 
from the Rock Island District COE office prior to starting your work. 
 
You have 30 calendar days from the date of receipt of this letter to make any request as outlined above. If 
you have any questions, please contact Derrick Klimesh, Assistant State Conservationist-Compliance, at 
derrick.klimesh@usda.gov or by telephone (515) 323-2243. 
 
Sincerely, (4-5 returns) 
 
 
 
Jon Hubbert  
State Conservationist 
 
Enclosures:  NRCS-CPA-026-WC, Certified Wetland Determination Map 
 
cc: Derrick Klimesh, Assistant State Conservationist-Compliance, NRCS, Des Moines, IA 

Name, District Conservationist, NRCS, County, City, State 
 Name, County Executive Director, FSA, County, City, State 

 Landowner/All Associated with Tract Name, Full Address, City, State, Zip Code 
 

mailto:derrick.klimesh@usda.gov
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Iowa NRCS Off-Site Wetland Mitigation Procedure Checklist 
 
1)Person submits request in writing for off-site mitigation of a wetland that has existing certified wetland 
determination. 

☐ go to step 2 
2)NRCS District Conservationist (DC) explains mitigation process and requirement to locate potential mitigation 
sites to the person (provide copies of this checklist and procedure).  Area and/or State Office staff will assist as 
needed. 

☐ go to step 3 
3)Mitigation sites 

☐ Person submits potential mitigation site(s) to the DC. Go to step 4 
☐ Person does not submit potential mitigation site(s) to the DC. END. NRCS documents the decision in 

writing that the person is not mitigating.  
4)Qualified personnel evaluates the proposed mitigation site(s), including functional assessment on both the 
proposed “MIW” and “MWM” site(s). 

☐ Evaluation indicates potential for wetland mitigation. Go to step 5. 
☐ Evaluation indicates lack of potential for wetland mitigation. Return to step 3.  

5)NRCS State Office or authorized personnel review proposed mitigation site(s). 
☐ NRCS State Office approves proposed mitigation site. Go to step 6. 
☐ NRCS State Office does not approve proposed mitigation site. Return to step 3. 

6)NRCS notifies the person in writing with mitigation requirements, including provision of data from functional 
assessments.  Person is instructed to decide whether or not mitigation is the preferred option and to request a 
mitigation plan, in writing, if mitigation is chosen. 

☐ Person requests NRCS to develop a mitigation agreement in writing. Go to step 7. 
☐ Person does not make a request in writing for the development of a mitigation agreement. END. NRCS 
documents the decision in writing that the person is not mitigating. 

7)NRCS authorized personnel develop wetland mitigation agreement. 
☐ NRCS and the person agree on a Wetland Mitigation Agreement (WMA). Go to step 8. 
☐ NRCS and the person do not agree on the Wetland Mitigation Agreement (WMA). END. NRCS 
documents the decision in writing that the person is not mitigating. 

8)Wetland Mitigation Agreement becomes final. 
☐ Person signs WMA. Go to step 9. 
☐Person does not sign WMA. END. NRCS documents the decision in writing that the person is not 
mitigating. 

9)NRCS authorized personnel complete a Hazardous Substance Review Checklist and Preliminary Certificate 
Inspection and Possession. 

☐ No unapproved uses/hazards are present. Go to step 10. 
☐ Unapproved uses/hazards are present. Return to step 3; retain documentation in the case file. 

10)Person orders a Preliminary Title Opinion and Iowa Title Guaranty Commitment and a separate environmental 
records search of the proposed mitigation site using scopes-of-work provided by the NRCS Easement staff.  This 
can occur at any time once the site is selected. 

☐ Records are returned with clear title and no concerning environmental records. Go to step 11. 
☐ Records are returned with unacceptable encumbrances or exceptions. Process HALTS until the person 
provides clear title.  If unable to clear, return to step 3; retain documentation in the case file. 

11)Person secures a licensed surveyor following easement survey statement of work and has a legal land survey 
and description prepared for the mitigation site, including legal ingress and egress. 
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☐ Survey reviewed by Easement Program Specialist and concurred by Easement Program Coordinator. 
Go to step 12. 
☐ Survey errors are present and in need of correction. Process HALTS until corrections are made. If 
corrections are unable to be made, return to step 3; retain documentation in the case file. 

12)Person obtains an updated Preliminary Title Opinion, Iowa Title Guaranty Certificate, and an ALTA closing 
protection letter referencing the approved legal description provided by the surveyor. 

☐ Title records remain clear. Go to step 13. 
☐ New encumbrances or exceptions are revealed.  The process HALTS until clear title is provided by the 
person. Retain documentation in the case file, including if the process ENDS due to inability to provide 
clear title, or if there is a return to step 3. 

13)NRCS completes a DOJ Certificate of Inspection.   
☐ Go to step 14. 

14)NRCS State Office Easement staff will assemble all documentation of mitigation site, including Warranty 
Easement Deed, and provide to the Office of General Counsel for a Preliminary Opinion.  

☐ Favorable opinion by OGC – go to step 16. 
☐ Unfavorable opinion by OGC – go to step 15. 

15)In the case of an unfavorable OGC opinion, NRCS notifies the person of the issues that need to be resolved. 
☐ Items are resolved by the person. Return to step 14. 
☐ Items are not resolved by the person. END or return to step 3; retain all documentation in the case file. 

16)In the case of a favorable OGC opinion, NRCS provides the person with closing instructions.  Person provides 
the instructions to the title agent, and the easement will proceed with closing. 

☐ Closing documents are provided to NRCS for acceptance. Go to steps 17 and 18. 
☐ Closing documents are not provided to NRCS. END or return to step 3; retain all documentation in the 
case file. 

17)Person may begin implementation of the mitigation plan within the surveyed area at this time and proceed to 
step 18 during implementation.  

☐ Mitigation is being implemented according to NRCS standards and specifications as outlined in the 
WMA.   
☐ Mitigation is not being implemented according to NRCS standards and specifications as outlined in the 
WMA. Repeat step 17 until standards and specifications are met, or END, including all proper 
documentation. 

18)NRCS completes the Acceptance Page to be included with the Warranty Easement Deed.  This will be 
provided back to the closing attorney to be recorded.  
  ☐ Proceed to step 19. 
19)Person provides NRCS with copies of the Warranty Easement Deed and Final Iowa Title Guaranty Certificate.  
NRCS Area Staff will complete the Final Certificate Inspection and Possession.  Easement Specialist will 
assemble all documents for submission for OGC Final Opinion. 

☐ OGC issues favorable final opinion. Go to step 21. 
☐ OGC issues unfavorable final opinion. Go to step 20. 

20)In the case of an unfavorable OGC opinion, NRCS notifies the person of issues that need to be resolved. 
☐ Items are resolved by the person. Go to step 19. 
☐ Items are not resolved by the person. END or return to step 3. Retain all documentation in the case file. 

21)In the case of a favorable opinion, NRCS notifies FSA in writing that the person is implementing all practices 
of a Wetland Mitigation Agreement.  The planned conversion may commence, or program benefits may be 
reinstated per FSA rule and policy, 
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Functional Assessments (FA) Guide 

1. Determine location(s) needed for FA. 
2. Gather maps of the area including soils, lidar and certified wetland maps. 
3. Download the correct HGM FA models and worksheets from the Field Office Technical Guide 

(FOTG). 
a. Go to: https://efotg.sc.egov.usda.gov/#/ 
b. Select your state (i.e., Iowa) from the drop-down menu and click Submit 
c. Go to Section I and click the down arrow 
d. Go to Resource Evaluation Tools and click on the down arrow 
e. Right click on Wetlands (see highlighted below) 

 

 

 

 

 

 

f. A screen on the right will open with a list of documents 

 

i. Scroll to IOWA INSTRUCTION 180-394 – WETLAND FUNCTIONAL 
ASSESSMENT MODELS and click to open.  Note: this is current Iowa 
NRCS functional assessment instruction as of July 2, 2015. Exhibits for 
that instruction are also found in this section.   

ii. Select the HGM Model for the functional assessment area (see table 
below).  If you are uncertain reach out to Compliance Staff for assistance.   

 

https://efotg.sc.egov.usda.gov/#/
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4. Go to the field and collect data based on the HGM model for the area.   
5. Record the proposed and current field conditions as outlined in the HGM model. 
6. Using field and supporting data complete the correct HGM Functional Assessment 

Worksheet.   
i. Refer to corresponding HGM model for further explanation. 

ii. May include aerial imagery review for site evaluation. 

 

Definition of Functional Assessment Models 

Assessment models are simple representations of the relationship between attributes of the wetland 
ecosystem and the surrounding landscape, and the functional capacity of the wetland. Variables in the 
assessment model, such as plant species composition, over bank flow, and soil type, represent the 
attributes. Variables are assigned a sub-index ranging from 0.0 to 1.0 based on the relationship between 
the variable and functional capacity.  

Variables in the assessment model are assigned a sub-index based on a quantitative (i.e., interval or ratio) 
or qualitative (i.e., nominal or ordinal) scale data. When it is impossible or impractical to assign a sub-
index based on direct, quantitative or qualitative data, it may be possible to assign a sub-index based on 
an indicator. Indicators are easily observed or measured characteristics that are correlated with a 
quantitative measure of a variable.  

In addition to defining the relationship between variables and functional capacity, the assessment model 
defines how variables interact to influence functional capacity. The interaction between variables is 
defined using an aggregation function or logical rules. The result is a functional capacity index (FCI), 
which is the ratio of the functional capacity of a wetland under existing conditions, and the functional 
capacity of a wetland exhibiting reference standards for the regional subclass in the reference domain. 

 



  
Farm Production  
and 
Conservation 

Natural Resources 
Conservation  
Service 

 
Insert FO Address 
City, IA  Zip 
Voice (XXX) XXX-XXXX 
FAX (XXX) XXX-XXXX 

  

USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

CERTIFIED MAIL--RETURN RECEIPT REQUESTED  
 
Insert date here (2 returns) 
 
Participant Name 
Address  
City, State Zip (3 returns) 
 
 
Dear Participant Name: (2 returns) 
 
The Natural Resources Conservation Service (NRCS) has received confirmation that you have 
completed the restoration of the ** acres of CURRENT Wetland Label through a wetland 
restoration agreement with the NRCS for Farm #***, Tract #*** in *** County, Iowa (See 
attached documentation of completed restoration if available).  
 
Enclosed is an updated Certified Wetland Determination (CWD) Map for Tract #***. The map 
reflects that a wetland label of (NEW WETLAND LABEL) has been restored on Tract #*** (see 
attached). In cases where the areas were previously determined to be converted wetlands, this 
determination removes the converted wetland status from those areas. (EXPLAIN LABEL 
HERE: Example: The wetlands (W) label may be farmed under natural conditions, but with 
restrictions. If you conduct any activity that alters or modifies the wetland characteristic of 
Wetlands (W), such as adding new drainage tile, placing fill material into the wetlands, or 
removing woody vegetation in the wetlands, these acts may be considered wetland conversion.)  
 
This determination/delineation may not be valid for identifying the extent of the Corps of 
Engineers’ (COE’s) Clean Water Act jurisdiction for this site. If you intend to conduct any 
activity that constitutes a discharge of dredged or fill material into wetlands or other waters, you 
should request a jurisdictional determination from the local office of the COE prior to starting 
the work. Other federal, state, or local permits or restrictions may apply to activities impacting 
wetlands. If you have any questions, please contact me at (XXX) XXX-XXXX. 
 
Sincerely, (4-5 returns) 
 
 
 
Your Name 
Designated Conservationist 
 
Enclosures:  NRCS CPA-026-WC, CWD Map  
 
cc: Name, District Conservationist, NRCS, City, IA 
 Name, County Executive Director, FSA, City, IA 
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 USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

 
CERTIFIED MAIL--RETURN RECEIPT REQUESTED  
 
Insert date here (2 returns) 
 
Participant Name 
Address  
City, State Zip (3 returns) 
 
 
Dear Participant Name: (2 returns) 
 
The Natural Resources Conservation Service (NRCS) has received confirmation that you recently 
purchased *** acres of farmed wetland pasture mitigation credits from Iowa Agricultural Mitigation 
Inc. The Iowa Agricultural Mitigation bank is an approved USDA bank. Your purchase of these credits 
mitigates *** acres of wetlands in field *** of Tract #*** in *** County, Iowa (See attached aerial 
photograph).  
  
Enclosed is a Final Certified Wetland Determination (CWD) for Tract #***. A Mitigated Wetland 
Label (MIW) has been applied to the identified farmed wetland pasture on Tract #***, (see attached). 
The MIW label allows you to conduct drainage activities on those wetlands without jeopardizing your 
USDA program eligibility. In cases where the areas were previously determined to be converted 
wetlands, this determination removes the converted wetland status from those areas.  
 
Mitigation means, the functions, values, and acres of the wetland to be converted have been replaced at 
another location. Mitigated wetlands may be manipulated (tiled, drained, ditched, filled, etc.). 
Manipulation of MIW sites will not result in the loss of eligibility for USDA program benefits.  
 
If you do not consider the results of this determination to be adverse to you, no further action is 
required by you. If you feel that this determination is adverse, you may appeal this final determination 
by requesting an appeal in writing to either the FSA County Committee, or to the National Appeals 
Division (NAD), at the addresses listed below within 30 calendar days from the date of receipt of this 
notice. 
 
 Local FSA County Committee 
 Address 
 City, Iowa Zip Code 
 
 Or 
 
 National Appeals Division (NAD) 
 Post Office Box 68806 
 Indianapolis, IN 46268-0806 
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This certified wetland determination/delineation has been conducted for the purpose of implementing 
the wetland conservation provisions of the Food Security Act of 1985. This determination/delineation 
may not be valid for identifying the extent of the Corps of Engineers’ (COE’s) Clean Water Act 
jurisdiction for this site. If you intend to conduct any activity that constitutes a discharge of dredged or 
fill material into wetlands or other waters, you should request a jurisdictional determination from the 
local office of the COE prior to starting the work. Other federal, state, or local permits or restrictions 
may apply to activities impacting wetlands. 
 
Sincerely, (4-5 returns) 
 
 
 
Your Name 
Designated Conservationist 
 
Enclosures:  NRCS CPA-026-WC, and CWD Map  
 
cc: Name, District Conservationist, NRCS, City, IA 
 Name, County Executive Director, FSA, City, IA 
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USDA is an equal opportunity provider, employer, and lender. 

United States 
Department of 
Agriculture 

CERTIFIED MAIL--RETURN RECEIPT REQUESTED 
 
Insert date here (2 returns) 
 
Participant Name 
Address 
City, State Zip Code (3 returns) 
 
 
Dear Participant Name: (2 returns) 
 
The Natural Resources Conservation Service (NRCS) has received your request for a new Certified 
Wetland Determination. This letter is to notify you that a Certified Wetland Determination has 
previously been completed for your Farm #XXXXX, Tract #XXXXX, located in XXXXXX County, 
Iowa.  
 
The previously Certified Wetland Determination was completed in accordance with the National 
Food Security Act Manual (NFSAM) Wetland Identification procedures Title 7, Part 12 and Title 7, 
Part 12, Sections 12.5(b) and 12.2 of the Code of Federal Regulations (CFR). A copy of the 
previously completed Certified Wetland Determination has been enclosed for your review. The 
Certified Wetland Determination was completed for the same area as your Current Wetland 
Determination request. Therefore, your current request for a wetland determination will not be 
completed by the NRCS. 
 
If you agree with the enclosed Certified Wetland Determination, no further action is required on your 
part. The enclosed Certified Wetland Determination may be relied upon when making decisions 
involving current and future drainage projects. If additional information is needed, please contact your 
local NRCS office. 
 
If you disagree with the enclosed Certified Wetland Determination, you may request a review of the 
determination if one of the following applies: 
 
1) If a natural event has altered the topography or hydrology of the subject land to the extent 

that the final certification is no longer a reliable indication of site conditions, or 
2) The NRCS concurs that an error exists in the current wetland determination. 
 
A request for review of the enclosed Certified Wetland Determination must be in writing and include 
what natural event occurred that changed the hydrology or topography or what error exists in the current 
wetland determination. Failure to include this information will result in your request for a review being 
denied. 
 
You have not been offered appeal rights as the appropriate time-period to request an appeal of the 
XXXXX determination has expired. 
 
If you feel that NRCS’s decision to deny appeal rights is in error, you may request a review of this 
decision from the Director of the National Appeals Division (NAD). Your request must be in writing 
and state the reason that the decision to deny appeal rights is in error. You may contact the NAD 
Director at the following address: 
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 Director  
 USDA, National Appeals Division  
 1320 Braddock Place, 4th Floor  
 Alexandria, VA 22314 
 
You have 30 days from receipt of this letter in which to make an appeal to the NAD Director. 
 
The 2014 Farm Bill connected producer eligibility for Federal crop insurance premium subsidy to 
compliance with the wetland conservation provisions. Eligibility for most USDA programs is lost for 
any wetland conversions that have occurred after December 23, 1985. However, only wetland 
conversions that occur after February 7, 2014, result in ineligibility for federal crop insurance premium 
subsidy. 
 
This certified wetland determination has been conducted for the purpose of implementing the 
Wetland Conservation Provisions of the Food Security Act of 1985, as amended. This 
determination may not be valid for identifying the extent of Clean Water Act jurisdiction for this 
site. If you intend to conduct any activity that constitutes a discharge of dredged or fill material into 
wetlands or other waters, you should contact the U.S. Army Corps of Engineers district office prior 
to starting work. 
 
In order to maintain your eligibility for USDA program benefits, contact your local NRCS office prior 
to performing any land altering activities (tiling, land clearing, ditching, drainage maintenance, filling, 
leveling, removal of woody vegetation, or dredging) in or adjacent to the identified Wetland (W), 
Farmed Wetland (FW), Farmed Wetland Pasture or Hayland (FWP), or Not Inventoried area(s). 
 
If you need further assistance or have questions about this matter, please contact me at (type email address) 
or by telephone at (XXX) XXX-XXXX. 
 
Sincerely, (4-5 returns) 
 
 
 
Your Name 
Your Title (2 returns) 
 
Enclosures:  (list enclosures i.e., map and Form CPA 026)  
 
cc: Name, District Conservationist, NRCS, City, IA  

Name, County Executive Director, FSA, Address, City, IA 
Landowner/All Associated with Tract Name, Full Address, City, State, Zip Code 
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